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Note:  Do NOT connect the spectrometer to the computer until you install the OceanView 

software. Follow the instructions in the Installing OceanView section below to properly 

connect and configure your system. 
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Introduction to OceanView 

Welcome Screen 

When you launch your OceanView application, the Welcome screen appears asking if you 
would like to run a spectroscopy wizard, open a previously stored project or session or open in 
Quick View (formerly Scope) mode showing raw, unprocessed data. 

 Run a Wizard: Asks you to select your data source (spectrometer), and then allows you 
to choose the type of spectral analysis you want to perform. 

 Load Project: Loads a previously stored project. 

 Restore Previous Session: Loads the last Schematic and View window configurations 
used. 

 Quick View: Displays the device signal in Quick View mode. 

Data Window 

 Unprecedented customizability with graph, table, scalar and color views 

 Used to monitor measurement 

 Provides controls to maintain measurement (e.g. store new background/reference) 

 Hides other controls to minimize clutter 

 Highly customizable with persistence to remember user settings 

Schematic View  

The Schematic View presents data from your device(s) in a diagram format. The Schematic View 
provides you with all of the functionality of the Window view, plus the following enhanced 
capabilities: 

 Algorithm nodes – allow for math functions such as ratios, adding multiple spectra, and 
adding a constant to spectra. 

 Set a subrange – ability to focus on a specific subset of the spectrum 

 Interpolate spectral data – evenly space data from two or more spectra to analyze them 
mathematically 

 Retrieve device properties such as serial number, firmware version, wavelength and 
total number of pixels 

 Send a single value (such as TEC temperature, integral, average over a specific 
wavelength range) from the device to the Scalar view to analyze the value over time 

 Preview spectra in graphs at every step in your process 

 Easily add new Graph and Table Views 
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Persistence 

OceanView remembers user settings such as acquisition parameters, file locations, customized 

graph layout and other user settings.  The following features are persisted in OceanView: 

 Acquisition parameters and controls 

 Graph settings 

o Gridline settings 

o Background color 

o Graph fonts  

o Tick mark spacing 

o First 20 trendline colors 

o Annotations 

o X and y axes  

o Cursor position 

 File locations 

o Saved experiments 

o Calibration files 

o Location for exported data files 

Installing OceanView  

OceanView Minimum System Requirements 

Monitor resolution: 1024 X 768 or higher 
RAM:   1.5 GB or higher 
Processor:  Intel Core II Duo @ 1.4 GHz or better 
   Intel Core Duo @ 2.0 GHz or better 
   AMD Athlon Neo X2 @ 1.6 GHz or better 
   Intel Atom @ 2.13 GHz or better 
   AMD Athlon 64 x2 @ 1.7 GHz or better 
   Note:  Most processors produced in 2010 and later should be okay. 
HD Space:  300 MB free space 

Note:  Do NOT connect the spectrometer to the computer until you install the OceanView 

software. Follow the instructions below to properly connect and configure your system. 
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Installation 

OceanView is downloaded from the OceanView download link you received in your email.     

Installation instructions are included below for installing OceanView on each of the following 

operating systems: 

 Microsoft Windows – XP, Vista, 7, 8; 32-bit and 64-bit 

 Apple Macintosh – OSX 10.5 or higher on Intel processor 

 Linux – Any version released for an x86 or amd64 platform since 2010 Example: 

CentOS(Version 5.5), and Ubuntu (version 10.4LTS) 

Installing on a Windows Platform 

Total download is approximately 64 MB (32-bit) or 71 MB (64-bit). 

► Procedure 

1. Close all other applications running on the computer. 

2. Start Internet Explorer. 

3. Navigate to the link you received to the OceanView software in your email and click on 

the OceanView software appropriate for your Windows operating system. 

4. Save the software to the desired location. The default installation directory is \Program 

Files\Ocean Optics\OceanView.  

5. The installer wizard guides you through the installation process. The OceanView icon 

location is Start | Programs | Ocean Optics | OceanView | OceanView and the current 

user’s desktop. 

Installing on a Macintosh Platform 

You must be logged on as an administrative user to install OceanView on your Mac. Total 

download is approximately 35 MB. 

Note:  Newer versions of MacOSX do not ship with Java so you may need to manually install a 

recent Java release before installing OceanView.  Instructions to download a recent Java release 

for different versions of OSX can be found at: 

http://support.apple.com/kb/HT5648  

There is also a direct link for the Java for OSX 10.7.3 and newer at  

http://www.java.com/en/download/manual.jsp#mac 

  

http://support.apple.com/kb/HT5648
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► Procedure 

1. Navigate to the link you received to the OceanView software and download the installer 

(OceanViewSetup_Mac.dmg). 

2. Double-click the OceanViewSetup_Mac.dmg file to mount the disk image. A new 

OceanView icon resembling a disk drive appears on your desktop. The new icon should 

open automatically (if it doesn’t, double-click it). 

3. Drag the OceanView.app icon to the Applications folder icon to install.  OceanView can 

then be launched from the Applications folder.  If desired, double-click the Applications 

folder and drag the OceanView icon from Applications to the Dock to be able to launch 

it more conveniently. 

4. When the installation is complete, drag the OceanView drive icon to the trash can. 

Installing on a Linux Platform 

Total download is approximately 75 MB (32-bit) or 67 MB (64-bit). 

► Procedure 

1. Navigate to the link you received to the OceanView software in your email and 

download the appropriate Linux OceanView installer.   

The example below is for a 64 bit installer downloaded to the Desktop.  Change 64 to 32 and 

the file location as needed for your installation. 

2. Start a terminal window and enter the following commands: 

 

chmod 755 ~/Desktop/OceanViewSetup_Linux64.bin 

sudo ~/Desktop/OceanViewSetup_Linux64.bin 

You are prompted for your password, which allows you to execute the setup as root. Contact 

your system administrator if you do not have the password.  If the sudo command does not 

work (it may not be set up for your user account), then enter the following: 

su 

(enter password for root) 

~/Desktop/OceanViewSetup_Linux64.bin 

The Linux version of OceanView requires some libraries that may not be installed by default, 

depending on the Linux distribution. The following are libraries are required, and are not 

provided as part of OceanView: 

 libstdc++ version 6 or newer 
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 libXp version 6 or newer  

 libusb version 0.1.10 or newer (should be provided in a libusb package or can be 

downloaded from http://libusb.sourceforge.net/download.html#stable). 

It may be necessary to modify SELinux (Security Enhanced Linux) restrictions before OceanView 

will run. It is possible to remove SELinux auditing by running 'setenforce Permissive' as root or 

by customizing your SELinux policies. The OceanView installer does not modify system security 

settings. 

Note: 

The default installation directory is /usr/local/OceanOptics/OceanView.   

A symbolic link is put in /usr/bin so that you can enter OceanView on any command line to start 

the program. 

The OceanView icon  location varies by installation, but will be under either Applications or 

Other under the Application Launcher menu. 

Device Driver Issues with Windows 64-Bit 

Hardware device driver installation is seamless on Microsoft Windows 32-bit operating systems 

when you connect your spectrometer to your computer. However, 64-bit Windows systems 

require a bit more care when connecting your spectrometer for the first time.  

If your spectrometer is not recognized by OceanView running on a 64-bit computer, you need 

to manually install the spectrometer drivers using the procedure below. 

Windows 64-bit Driver Installation Process 

Use the following procedure when connecting your spectrometer to a Windows 64-bit system.  

Steps may vary slightly depending on the version of Windows. 

► Procedure 

1. Open the Control Panel and click Device Manager. 

2. Under Other devices, right-click on the Ocean Optics spectrometer and choose update 

driver software. The following screen appears: 
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3. Choose Browse my computer for driver software. 

4. Navigate to C:\Program Files\Ocean Optics\OceanView\SystemFiles and click OK. Then 

click Next.  

5. When the following pop-up screen appears, choose Install this driver software anyway. 

 

6. When the driver installation is successful, the software will recognize your 

spectrometer.   
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Starting Your 10 Day Free Trial 
 

1. Double-click the OceanView icon on your Desktop to start the software.  

2. Click the Cancel button in the OceanView Product Activation dialog box that opens to 

start your 10 day free trial with a fully functional version of OceanView. 

Note:  All data and projects saved during your 10 day free trial will be available when the 

software is activated using a valid product key.  Contact info@oceanoptics.com to purchase 

OceanView licenses.     

Using Your Product Key to Activate Your Software 

Note:  An internet connection is required to activate your software using a valid product key.  

If an internet connection is not available, contact info@oceanoptics.com for the offline 

activation procedure.  

1. Double-click the OceanView icon on your Desktop to start the software. 

2. Click next in the OceanView Product Activation dialog box to enter your product key.   

3. Copy the product key from the email you received and paste it into the product key box. 

4. Click the Register Software button to validate your product key. 

5. Click Finish to complete the software registration. 

If you see the message below, check your internet connection and click the Register Software 

button again.  If the computer is connected to the internet and you still cannot register your 

software contact info@oceanoptics.com for assistance. 

 

Deactivating Your Product Key for Software Installation on another 

Computer 

With the exception of multi license packs, your product key is only valid for use on two 

computers at a time.  A deactivation option is available in OceanView if you want to deactivate 

your product key on one computer so you can use it on another computer. 

1. Go to Help | Licensing. 

2. Click Deactivate and the following warning will appear: 

mailto:info@oceanoptics.com
mailto:info@oceanoptics.com
mailto:info@oceanoptics.com
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3. Click Yes to deactivate the license. 

4. OceanView will close and the license will be available for use on another computer. 

Frequently Asked Questions 

How do I navigate the new OceanView user interface? 

When you start OceanView, a Welcome screen appears asking what you would like to do.   

 

The options are to:   

 Run a Wizard: Asks you to select your data source (spectrometer), and then allows you 
to choose the type of spectral analysis you want to perform. 
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o Spectroscopy 
 Quick View Minus Background (formerly Scope Minus Dark)  
 Absorbance 
 Reflection 
 Transmission 
 Raman 
 Quick View Fluorescence 
 Relative Irradiance 
 Absolute Irradiance 

o Color 
o Photometry 
o Concentration 
o Energy, Power, Photons 

 Load Project: Loads a previously saved project. 

 Restore Previous Session: Reloads the Schematic and view window configurations as 
they were when the software was closed.   

 Quick View: Displays the spectrum in Quick View mode showing raw, unprocessed data 
(previously referred to as Scope mode). 

Note:  OceanView has extensive context sensitive help.  Click the Help button in any dialog 

box for more details.  Tooltips are also available by hovering over a button or window for 

more information.  Help is also available using the Help option in the top menu. 

Run a Wizard 

Select Run a Wizard and click OK to open the Wizard selection dialog box.  Click Spectroscopy to 

open the Select Spectroscopy Wizard dialog box.  Select the processed mode you want to enter 

and Click Next.  The Wizard will take you through all the necessary steps to optimize your 

acquisition and enter the desired processing mode.  

The Wizards can also be accessed by clicking the Create a new spectroscopy application button 

or by clicking Create a new spectroscopy application option from the File menu. 

 

Load Project 

With the new Persistence functionality and ability to save and reload projects, you can quickly 

enter a processed mode by reloading a previously saved method.  Select Load Project to view 

the list of previously saved projects.    Click the project you want to load and click Ok.  Your 
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project will reload and even warn you if you are reloading Reference or Background data that 

should be updated to ensure accurate measurements. 

Note: To load a project, you must have the same spectrometer(s) that were used to create 

the project connected to the computer before you can load the project.  The project will not 

load if the spectrometers used to create it are not connected to the computer.        

You can also load a project by clicking the Open project button or clicking the Open project 

option from the File menu. 

 

Save projects by clicking the Save project button or selecting the Save project option from the 

File menu. 

 

Restore Previous Session  

Select Restore Previous Session and click OK to open the software just as you left it when you 

last closed it.  The settings and customization from the previous session will reload.  If the 

previous session included Reference and Dark data, you will be warned that you are reloading 

data that should be updated to ensure accurate measurements. 

Note: To restore a previous session, you must have the same spectrometer(s) that were 

connected when you last closed OceanView connected to the computer before you can 

reload the session.  The session will not load if the spectrometers used to create it are not 

connected to the computer.        

Quick View 

Select Quick View to display spectra for all the attached devices in a raw, unprocessed data 
view useful for setting acquisitions parameters and troubleshooting.  This mode was previously 
referred to as Scope mode. 

How do I get into Scope mode? 

Scope mode has been renamed Quick View in OceanView.  To display a Quick View spectrum 

for all the attached devices: 
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 Select the Quick View option from the Welcome Screen and click OK. 

 Click the x in the upper right hand corner of the Welcome Screen. 

Tip: Remove the checkmark from the “Show on startup” option in the Welcome Screen and the 

software will also start in Quick View. 

 

Where are my Acquisition Controls? 

To provide a cleaner, more relevant user interface and easier selection of an acquisition when 

multiple acquisitions are running, all the acquisition controls have been moved to the 

Acquisition Control Panel accessed in the Graph View window by clicking the Acquisition 

Controls button. 

 

The Acquisition Control Panel can also be accessed in the Schematic window by clicking the 

Acquisition Controls node. 
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When you click the Acquisition Controls button in the Graph or Schematic View, the Main 

Controls tab of the Acquisition Parameters Controls opens. 

 

Note: Different types of acquisitions are available for different devices including: Spectrometer, 

I²C, SPI, Board Temperature, Thermo-Electric Cooling and Analog In. The controls available in 

the Acquisition Parameters Controls vary based on the type of acquisition is selected.   

Add additional acquisition controls to the Main Controls tab by clicking the Add/Remove 

Controls tab and checking the boxes next to the desired feature.  When checked, the controls 

for these features will show up on the Main Controls tab.  Unchecking a feature does not 

disable the feature.  It only hides the controls on the Main Controls tab.  The spectrometer type 

will determine which controls are available in the Add/Remove Controls tab.  The 

“Spectrometer” feature is already checked and grayed out.  This feature places certain 

necessary spectrometer controls on the “Main Controls” tab and cannot be removed.  

Note:  If a control is shown in the “Main Controls” tab by selecting it in the "Add/Remove 

Controls" tab that setting will be pushed to the device before every update.  If multiple 

acquisitions have visible controls for the same feature on the same device, the device will 

alternate between them, possibly resulting in rapid changes of state (e.g. lamp control or  
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How do I get into Scope – Dark mode? 

Background subtraction (formerly Dark subtraction) is done to eliminate any extraneous light 

that might compromise useful data.  Light from sources other than the designated reference 

lamp including ambient light, stray reflections or scatter will be accounted for by storing a 

Background. Other undesired effects such as thermal noise and hot pixels can also be measured 

and eliminated with a proper background spectrum. 

Scope Minus Dark has been renamed to Quick View Minus Background in OceanView.  Quick 

View Minus Background mode is entered using the Quick View Minus Background Wizard to set 

your acquisition parameters and store a Background spectrum.  When the Background 

spectrum is stored, an Update Background button (Gray Light Bulb) is added to the Graph View 

to enable Background update as needed. 

Tip: Save your Quick View minus Background experiment as a Project and reload it using the 

Open Project button to quickly enter Quick View minus Background mode. 

Where did my S, A, T, R and I and light bulb buttons go?  

The processed modes available in SpectraSuite by clicking on the A, T, R and I buttons are 

available in the new software through the Spectroscopy Wizard or by loading a previously saved 

experiment created for one of these processed modes.   

To access the Spectroscopy Wizards, click the Create new spectroscopy application button  

 

or select the Create new spectroscopy application button from the File menu to open the 

Wizards dialog box. 
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Click Spectroscopy to open the Select Spectroscopy Wizard dialog box.  Select the processed 

mode you want to enter and Click Next.  The Wizard will take you through all the necessary 

steps to optimize your acquisition and enter the desired processing mode.  

 

Tip: Save your Absorbance, Transmission, Reflection or Irradiance experiment as a Project and 

reload it using the Open Project button  
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or by clicking the Open Project button option on the File menu.  When you load a project with a 

Reference and Background buttons will be available in your Graph View for updating the 

Reference and Background spectra.   

 

 

How do I find my Peaks? 

Find the peaks in your spectrum by clicking the View Spectrum Peaks button in your Graph 

View. 

 

The Configure Peak Metrics wizard takes you through a few quick steps to setup your peak 

finding parameters. 
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The steps are: 

 Set baseline level 

 Choose your peak finding method and set peak finding criteria and optional spatial 

filtering 

 Select which peak parameters to display them on the graph, in a table or both 

Make adjustments to peak finding parameters and criteria in the new peak menu that opens. 

 

Close the peak menu and remove peak information from the graph by clicking the View 

Spectrum Peaks button. 

 

What is the Schematic and how do you use it? 

What is the Schematic? 

The Schematic View is a window that shows icons representing the different devices and 

processes in your project as nodes and links between the nodes.  In the Schematic, you can 

view and manipulate the flow of data from your spectrometer through your processing steps.  
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Data flow is represented by the use of arrows and lines that connect different nodes.  The 

nodes represent points where data is processed or manipulated. 

The Schematic provides you all the functionality of the Graph View window, plus the following 

enhanced capabilities: 

 Algorithm nodes – allow for math functions such as ratios, adding multiple spectra, and 
adding a constant to spectra. 

 Set a subrange – ability to focus on a specific subset of the spectrum 

 Interpolate spectral data – evenly space data from two or more spectra to analyze them 
mathematically 

 Retrieve device properties such as serial number, firmware version, wavelength and 
total number of pixels 

 Send a single value (such as TEC temperature, integral, average over a specific 
wavelength range) from the device to the Scalar view to analyze the value over time 

 Preview spectra in graphs at every step in your process 

 Easily add new Graph and Table Views 

Using the Schematic 

Spectrometers: 

 All spectrometers detected by the software are automatically placed on the Schematic. 

 Add new devices to the Schematic using the Device Manager button or clicking F5.  Click 

Rescan to scan and connect to new devices.   

 

• Double-click the spectrometer icon to open the Device Features window and view all 

available device characteristics (serial number and firmware version). 

Acquisitions: 

 Start a new acquisition for a spectrometer by right-clicking the spectrometer icon and 

selecting New Acquisition to choose from the list of available acquisitions.   

 Double-click the Acquire node to open the Acquisition Parameter Controls menu and 

configure the acquisition.   
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Adding Nodes to the Schematic: 

 Add a data view (Graph, Scalar or Table view windows) or processing nodes to the 

Schematic by right-clicking on an empty region of the Schematic and selecting a node 

from the menu. 

 To connect nodes: 

o For PC users, hold down the Control button and left-click on the first node. While 

still holding the mouse button, drag a wire from the first node to the second 

node.  When the cursor is over the second node, release the mouse button and 

the Control button - Control + Click + Drag 

o For Mac users, hold both the Shift button and the Control button while wiring a 

connection - Control + Shift + Click + Drag 

 Double-click a node to view available feature controls and access context sensitive help.  

 Delete a connection between node by moving the cursor over the wire, right-clicking on 

it and selecting “Delete Connection” Right-click the node to Rename, Duplicate or 

Delete it 

 Double-click a View node to go to the Data View window for that node 

 If two nodes cannot be connected, OceanView will not allow you to make the 

connection - view the context sensitive help for the node to determine the proper 

connection by double clicking the node and clicking the Help button. 

Tip: Use the Wizards to create your Schematic and customize as desired using more than 70 

algorithm nodes. 

How do I Splice spectral data? 

OceanView has a post processing mode that allows you to splice spectral data from multiple 

spectrometers into a single spectrum.  Note that spectral splicing can only be done with 

processed spectra - Absorbance, Reflection, Transmission, Relative Irradiance or Absolute 

Irradiance.   

Open the Splice Spectra dialog box by clicking the Splice Spectra button in the graph window. 

 

Click the Add Range button to select sources of processed data for the spliced spectrum.  
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Adjust the spectral ranges for the sources and click Apply to splice the spectra into a single 

spectrum. 

 

For additional help, click the Help buttons available in most OceanView dialog boxes for 

extensive context sensitive help.  Help is also available by selecting the Help Contents option 

from the Help menu at top of your software window. 


